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  This Paper is designed to show how to make a basic Material, and the applying of a 
Textured Material to a polygon mesh, plus introduction to UV editing.  It is somewhat 
wordy and can be confusing due to what is written in the Remember This. 
 
  To begin with Blender has 3 main types of Materials. 

1) Material:  properties for colors are set by numbers from a 24 bit RGB palette, and 
effects such as Specular and Alpha come from an 8 bit Grey scale palette. 

2) Textured Material:  A material where any of the property channels contains a 
bitmap image. 

(Note: many artists maybe use to simply referring to a ‘Material’ regardless of 
whether it contains a bitmap or not.  However in the OpenGL render system a 
distinction is made as inclusion and calls to various Dynamic Libraries are required to 
allow for use of the bitmapped channels.  Meaning a programmer needs to know if a 
Material contains a texture or not for rendering concerns.) 
3) Shaders: use mathematical equations to derive number used for values. 

 
  That is a very simplified explanation, and much more is involved in making and 
applying Materials/Textures but sufficient for this paper.  
 
Read Before Continuing
  Blender’s background is as an art tool for working with a game engine, and hence 
handling of Materials in Blender can follow 2 pipelines. One for producing art assets for 
inclusion in Blender’s Game Engine, and the other for use as a stand alone Render 
Engine to produce images and/or animations. 
  So some features such as Data and Material Blocks and the attaching of Material 
Nodes are design for use in Game Engines in general, and may not have a function while 
simply rendering images.  If you are making assets for a game try to find out what 
properties (channels, nodes, data blocks…) can be used in your objects, especially if you 
do not intend using the Blender Game Engine. 
 
  Also take into account Blender uses OpenGL in its Renderer, meaning Shaders and such 
designed for use in Direct X may need to be rewritten to work with OpenGL.  Then again 
if Blender used Direct X chances are they’d have to pay a licensing fee to Microsoft and 
you’d not be getting the program for free.   
 
 
 
 
 
 
 
 
 



 
  Above is my ‘Default’ setup for using Blender, which as a heavy user of 3dsMax and 
Maya is designed to more mimic their UI’s.  However when I am doing texturing I prefer 
one big 3D View and 2 Button Windows for getting at material properties and images, 
with switching one of those to the UV Editor when needed.   
  Why, because I know I’ll be moving back and forth amongst these ‘Window Types’ so 
I’d rather to be able to view them all at once then flip back and forth between the various. 
  If you notice all I really need to do from my Default is ‘Join’ each pair of the upper and 
lower 3dViews and switch the now middle window to “Button Type’.  The timeline stays 
incase I’m working with an animation as a texture. 
 
  You Do Not have to follow this setup!  It’s just how I like to work and I put it up here as 
a reminder that you can quickly reshape your own UI configuration.  Blender in version 
2.42a does not have pop up work areas for such items as UV manipulation as you might 
be use to in Max or Maya.  So I find that when working in Blender it’s best to lay out 
your screen ahead of time to take in to consideration windows types you will be using, 
and how large an area you’d like to use for one. 
 
   Important Note: 
   If you do try using vertical columns for windows you’ll find in some cases not all 
‘Buttons’ action panels will show.  You can remedy this by clicking the small arrows 
that open/close action sets (mesh tools, etc), or if using a wheel mouse scrolling the 
wheel while in a vertical ‘Buttons’ window will move the actions set up and down.  Also 
when using the ‘UV Editor’ with a wheel mouse scrolling the wheel zooms in and out 
plus click/hold allows you to move the work area around.     
 
 
MATERIALS – a few things first 
  Do a File> New to get a fresh scene with a 
Default Cube, the Cube is automatically selected 
and has a material created for it.  Now look to 
your Buttons Type- Editing Panel- Materials 
buttons for the ‘Links and Pipeline’ actions. 
1) Notice buttons for ‘OB’ & ‘ME’, these two 
buttons are to set the link between the Mesh and the Material.  (OB) means link material 
data directly to the object, while (ME) means the link is made to a ‘Material Data 
Block’ associated with the Mesh.  Observe in the Mesh’s name box you see ME: Cube, 
this (ME:) indicates that this texture is assigned to a Material Data Block and not directly 
to the object itself. 



>>>>>>>>>>>>>>> 
Why should you be concerned? 
  Here is where you must begin to understand how Blender is both for Rendering and 
Game Asset Creation.  In most Game Engines textures and meshes are stored separately 
and a ‘Material Node’ (notice Nodes button) is used to associate Material sets with 
Meshes.  One reason for this is space saving, and example:  I build a mesh of a man, and 
texture him one way in a blue suit, in another in t-shirt and jeans.  If the texture is 
attached to the object I need both models with their respective textures in memory to 
display both.  If separate as mesh data and texture data you only need to load one mesh 
and two texture sets into memory.  The engine can instance the geometry with node and 
then assign which of the two texture data sets it wants.  Thus freeing RAM space up for 
other uses.  
  Also if you are Exporting to another 3D program or your own Game Engine you need 
to know if the ‘Exporter’ or your ‘Engine’ can deal with Blender Material Data Blocks, 
or do you need to use (OB) and direct connect the Material to the Mesh. 
  If your intention is only to use Blender to Render or as your Game Engine this is less of 
a concern. 
>>>>>>>>>>>>>>> 
 

2) This area shows how many Materials or on an object and which of those Materials 
is active. 

Note:  Blender as of 2.42a while supporting multiple Materials, does NOT support 
multiple Textured Materials.  Meaning your mesh can only have one Texture in its 
Material.  However Blender can display and render a material that is referencing a 
number of bitmap textures.  But this is not true Multi Sub-Object Materials as found 
in other 3D programs. 
 
3) Here is where you see Material Name, which you can change in this first box.  

Clicking and holding on the small up/down arrows to the far left allows you to 
ADD NEW material and shows a list of Materials already created which can be 
selected. 
  It is best to rename your Material to something your can remember and see from 
this list, as a complex scene might have a hundred textures or more.  And it’s 
harder to find your rock texture when Materials are named Material001 through 
Material100 

        ‘X’ button removes the link between the Object and currently assigned Material, 
      the small middle icon (a car-auto) will attempt to automatically name your 
      Material; and the ‘F’ button saves the Material Data Block with file even if no  
      objects are using it. 
 
4) ‘Nodes’ button again deals more with meshes being used in Game Engines.  

(a Node for lack of a better term is like Helper Object to which various properties 
and functions can be assigned depending on what the Node is for.  This paper is to 
just do simple material creation-texturing in Blender and won’t really cover these.  
Artist making Game Assets are advised to research these further.) 
 



 
  While we are here click between the Material Block (ME) and Object (OB) link icons 
with your default Cube selected.  Notice how with (OB) picked all your actions in the 
Buttons Type Window disappear.  Why?  Because the Material was created for the 
Material Data Block attached to the Mesh, not the Object.  Now above all you see is 
‘Link New’, click and hold the up/down arrow and you’ll see your material listed there. 
  Again confusing, can you assign the same Material to ‘Link to Object’?  Yes, but you 
can also create a different Material here for linking.  You just need to understand one is 
directly associated with the object (OB), the other (ME) is associated to the Mesh through 
the use of a Material Data Block.   
 
  By first selecting (OB) and hitting ‘X’ icon, then doing the same for (ME) you can 
remove all Material Links to the Default Cube.  Or better yet just delete the Default Cube, 
also for the rest of this paper you’re on your own about Game Engine-Renderer-Export 
concerns for Materials. 
 
SOME COLOR 
  Setting Up: Now since it is easier to see certain Material values such as Specular effects 
with a more rounded shape than on the flat faces of a Cube, Add a Sphere to your scene 
Add> Mesh> UVsphere.  16 or so Segments then Rings should do fine.  Then add some 
smoothing to your UVsphere; (3D View Header Menu)  Edit Mode> Faces select all 
faces then in the (Buttons Window Type) Editing Panel click the ‘Smooth’ icon.  And 
finally set your 3D View window render type to Shaded. 
 
  Now reset your Buttons Window to ‘Shading’ Panel –Material sub-Panel, and look at 
‘Links and Pipeline’, you’ll find nothing shows up when you click either (OB) or (ME) 
as there is no Material linked to the Sphere.  Choose either one as this is just about 
general Material operations. 
 
  Now ‘click/hold’ the ‘up/down’ arrows for ‘Add New’, you’ll see 
the Default Material in the list but you want to start a new material s
select ‘ADD NEW” from list.  To get in the habit of renaming you
new Material; the Add New input should have switched to somet
like MA:Material.001, click the input box and come up with your 
own Material name.  When you hit ‘Enter’ a bunch of new Property/Channels Panels 
should show up. 

o 
r 

hing 

 
  A lot of items here will be ignored for much of this paper, but you should slide your 
cursor over many of the icons to see what they do.  Many are for more advanced 
‘Actions’ than are needed for just simple texturing.  But after you go through this paper 
and get the basics explore more actions on your own to see what they do. 
 
 
 
 
 



 
 
 
Material/Ramps -Material 

1) Col- stands for Color; in this case it’s the 
Diffuse color. 

2) Spe- stands for Specular color, or what is the 
color of your specular highlight.   

3) RGB-HSV click which style of color creation 
you prefer (Red-Green-Blue or Hue-Saturation-
Value).  Bit hard to see here but under the 
yellow 1 & 2 are where the slider 
value bars are located. 

4) ‘A’ means alpha or how 
transparent/opaque your material, 0-1 
with 1 being opaque. 

5) Shows current color and when clicked 
on brings up color picker. 

 
Some fun about Alpha (4) 
  When using Alpha in 
Blender you must also 
use ‘Ztransp’ found in 
the ‘Links & Pipeline’. 
  ‘Ztransp’ stands for Z 
depth Transparency and 
allows for objects 
behind the Transparent 
Material (Z-axis is 
depth moving away 
from you) to show 
polygonal geometry.  O
the background but is still opaque to geometry located behind it.  In the above picture the 
first is No Ztransp fully opaque, the second No Ztransp but 50% transparent but notice
the Cube behind does not show through.  Lastly same 50% but with Ztransp turned on
 

therwise if not on the Material only become transparent to reveal 

 
. 

 
 
 
 
 
 
 
 
 
 



 
 
 
Shaders/Mirror Tranps – Shaders                                  

   
different 

 Material to receive shadows. 
eci

ranslucency deals with amount of backside 

ent effect; or how much of the scenes 

rograms 

Shader types are available, mo

review 

1) Type of Shader used for Difuse  
2) Type of Shader used for Specular
3) Watch these areas change and offer 
options available with different Shader Types. 
(Different Shaders use different calculations to 
depict the ways color and light interact on a 
material, and may vary in their options to 
accomplish this.)  
4) Shadow icon for
5) If you have predefined Light Groups you can sp fy which one alone affects this 
Material. 
6) Tralu- T
shading.  Think of looking through a colored liquid, 
also such items as skin, leaves, and carved jade have 
translucency. 
7) Amb- Ambi
Ambient color is picked up by the Material. 
8) Emit- Color emitting level or what other p
call Self-Illumination. 
  Here are lists of what st will be familiar to users of other 
3D programs. 
 
P  

 current active Material, mainly has icons to choose the Preview display shape.   

So between Material and Shaders Action Areas you can create most basic color 

 

  Previews

The ‘O’ icon at the bottom turns off/on Over Sampling, or the Anti-aliasing of the 
Preview shape.              
 
  
Materials you need. 
 
 
 
 
 
 
 
 



 
TEXTURES – 3D Procedural             

ote:N   3D Procedural Textures use Mathematical formulas to produce color patterns such 
lly will Not work with most Game Engines.      

hading- Link and Pipeline’ click the ‘X’ icon to de-link.  Now again ‘ADD NEW’.       

f 
 

, 

 
ntly 

h
 no scene or material textures currently.  

t, 
 that way. 

oading a 3D Texture into the Scene: 
Go to Buttons- Shading- 

  
 

 

use
2) e you select the type of 

h as 
n 

 

3) 
If you change the name of your Texture 

 
 

as wood grain, marble, or noise and usua
 
  For now select your sphere and delete its Link to the Material you made, in ‘Buttons- 
S
  Next within the ‘Buttons Type- 
Shading Panel’ locate the ‘Texture’ 
areas for both the sub-categories o
Materials and Texture (you’ll want to
look at both usually at the same time
which is why I use the UI setup from 
the beginning of the paper). 
   Now the ‘Materials’ area deals with
textures assigned to the curre
selected Material, the ‘Texture’ area wit
have nothing showing as you have
  For workflow I find it easier to first make/load your Texture into Shading/Texture firs
and then have it already available for Shading/Materials so I will proceed in

 textures loaded into the current scene.  Both 

 
 
 
L
  
Texture and ‘ADD NEW’ 
which should now give you

1) Texture name which
you can change. ‘X’ 
to delete link to 
object/mesh data 
block, (car) 
autoname, and ‘F’
save with scene with 
Texture even if not 
Texture Type- is wher
texture you which to use.  It can be 2D suc

d by Object/Mesh. 

image, or 3d like Noise or Marble, also a Plugi
which is usually a 3rd Party Shader, a default 
installation usually has no items shown here when
selected. 
The darken bar that says ‘Tex’ indicates it is 
selected.  
it will be reflected here. 



 
 

4) In the Shading- Material Panel- Texture  two new tabs appear for ‘Map Input’ 
and ‘Map To’.  We will go further into this later.  

 new one (remember as you are 

6) 
 preview 

Note: S
automa ture with the Material of the selected Object.  You Do 

xture

5) Here you can again rename your Texture, use the ‘up/down’ arrows to select a 
previously loaded Texture from the list or Add and
now in the Material Panel this deals with the Texture as relating to the selected 
Material).  You can ‘Clear’ the Texture from the Material, the number of Objects 
using the Texture is indicated, plus the (car) icon for auto renaming. 
Your texture is now listed as being part of that Object/Mesh’s Material set, with 
the check mark meaning show/apply the effects of this Texture in the
window and on Render. 
ince you had the object/mesh selected when you loaded the Texture, Blender 
tically associated that Tex

Not have to have an Object selected to load a Texture.  To do so simply have nothing 
selected when you load the Texture. 
 
Working With a 3D Procedural Te  
For this part I will be using the 3D Procedural Marble as the texture.  While the work 

the Texture, options available for different 

nd 
om the list choose Marble.  A new Panel appears for ‘Marble’ actions/options and the 

 base pattern   2) Hardness of Noise engrained in pattern   3) Type of 

f type of calculation formula used for pattern, mainly a mixture of 

  
pipeline is pretty much the same for adding 
3D Textures can vary widely.  After you get the basics of this part go back and try out 
different 3D Textures like Noise, Wood, and Stucci to see what options they have. 
 
  In the Shading- Texture Panel click on the ‘Up/down’ arrows for Texture Type a
fr
Preview Panel now displays an image of the Marble Pattern. 
 

Texture Panel 
First up are Options for the Marble texture. 
1) Sharpness of
wave pattern. 
4) Controls for manipulating amount of Noise and Turbulence of the of the pattern 
5) Opens list o
Tessellation and Fractal generators. 
 
 
 
 



 
 
6) Shows Texture Type set to Marble, and you can see I renamed the Texture to Marble. 

) Grey scale display of pattern created with current settings. 

aterial Panel it is looking some thing like 

included in the Material. 

nd how I’m using Lambert 
. 

So why
the Texture Panel, the preview you see there is

 you will first open up the “Map To’ tab and in the 
rea, look for a wonderful magenta colored bar below an icon call ‘No 

d 
 

7
8) Displays active texture for the active Mat(ertial), World(Block), and Lamp 
 
How using different settings can affect the Marble pattern 

 
Meanwhile in the Buttons Type- Shading – 
M
this. 

1) How it sees the Marble pattern when 

2) Renaming has automatically been 
updated. 

3) Shows my Color and Specular 
settings, a
and Phong as my Shader Types
 pink?  Color attributes are not set in 

 based on a grey scale representation of the 
Marble calculations. 
 
  To change the colors
a
RGB’.  Your Marble Texture is getting its colors from your Col(or) an
this No RGB, observe image to the right.  Some 3D Procedural Textures
when created have no RGB color attached to them, so Blender assigns 
the color here to the Texture letting you know this. 
 
 
 
 
 
 
 
 
 
 



 
 
MAP TO 

 
Since we are already here let’s take a look at 

e Map To tab. 

, Amb(ient), Nor(mal), etc.  
 out 

   If you
wondering where my Map Channels are, this 

o
Texture Panel, then into the associate the T

th
1) Texture channels such as Col(or), 

Spec(ular)
Slide your cursor over them to find
more.   
’re use to 3dsMax or Maya and were 

is them, but in Blender there are no buttons to 
assign a Texture located by the Col(or) box.  
 the scene through the Buttons Type- Shading- 
exture to a Material in the Buttons Type- 

  In Blender you must Load a Texture in t

Shading- Material Panel.  And finally using ‘Map To’ chose the Channel(s) the Texture 
is to affect. 
  More About Channels:  In other 3D programs users maybe use to picking a Channel 
then loading a Texture into it.  If another Channel needs to use the same Texture you pick 

 

e they’re 
ect can be set to Invert the Texture being used.  Click the Channel Icon once to 

 

 

e 

t. 

ea; use
sliders.  The Icons ‘Stencil-Neg-No RGB’ only have an effect on certain 3d 
Texture types.  In the case of Marble click it and you’ll see the two colors 

 
 
 

that Channel and reload the Texture into in.  In Blender you can load that Texture into 
what ever Channel you simply by loading it once then selecting as many of the Channels 
you want in the ‘Map To’ area (there is of course no effect if the Channel can not make
use of the Texture Type).  So I could load a bitmap of a shirt and use it in Col(or), 
Spec(ular), and as my Disp(lacement) map by selecting all three icons here. 
   
  Also certain channels that use 8 bit information (2d or 3d Textures) to creat
eff
activate it, then click again to Invert, and the Channels name should turn Yellow to 
indicate it is inverted. 
  Here is a Cube I heavily 
sub-divided (edges-sub
divide multi) then added a 
Marble Texture which is
placed in both Col(or) and 
Disp(lace) Channels.  Not
on the second render ‘Disp’ 
is Yellow inverting the effec
 

2) No RGB color ar  the color box to click open a color picker, or the RGB 

assigned reverse. 



 
3) Type of ‘Mix’ used in blending the currently selected Texture’s Channels with   
others using that Channel.  Try them and watch the Preview window. 
 

 affect here for 
ol-Nor-Disp the Channel must be activated above. 

 
Not

4) How much does this texture affect the values for Col(or), Nor(mals), Var(lues), 
and Disp(lace), or think about this a percentage blend.  Also to have an
C

e:  This deals with draw order and ‘Mix’ing; your list of Textures is mixed from Top 
ottom, meaning 1  Texture in list is Mixed into the bto B ase Material values, and is 

eated as the new Base color.  The results then have the 2nd Texture’s affects Mixed in, 

 all and is 

new 

st

tr
and so on… 

Example:  1) Base color value  2)Wood 3D Texture  3) Magic 3D Texture 
4) Magic above Wood in Texture list   5) Magic below Wood in Texture list (all use full 
value affect).  Notice for Wood to work it needs to use the Base color for half of its 
effect, but Magic simply covers everything.  So if Magic is first it covers up
now the base color Wood works with.  But if Magic is second, Wood mixes with the 
Base color making a new one, but Magic when mixes next it simply covered up this 
Base color. 
 
MAP INPUT  
  Map Input deals mainly with UVmapping Type 
nd Map position and scale. 

Types of sources for UV co-

 user assigned UV’s.  
s, 

o a 

. 
2) 
3) 

 
 
  Re nly works with 3D Textures, a 2D Texture only has 

&V values. 

a
1) Various 

ordinates, with for this paper I only am 
concern with UV- for
And Orco or Original UV co-ordinate
which best I can tell is Blender assigns t
newly created mesh a set of UV’s as if a 
Flat project is done from a top down view
Texture offset values XYZ. 
Texture Scale Values XYZ. 

member for Offset and Scale Z o
U
 
 
 
 



 
 
WORKING WITH A 2D –Bitmap/Image 
Much of the above about working with 3D Procedurals is the same for a 2D 
itmap/Image.   

 by making sure the Texture box is selected 
 to load up 

o Shading- Texture do an ‘Add New’, but now for your Texture Type 

  
B
  First delete the link for your current Texture
then clicking ‘Clear’ in the Shading- Materials- Texture.  Now you will need
a Bitmap to use, s
select Image.  Two new Panels appear Image and Anim and Movie. 
Image 

1) ‘Load Image’ button brings up a standard 
file locating dialog in one of your other 
Windows temporarily. Here I’ve already 

2)  
 of 

der u
ot creating this mesh as a game asset 

3) oing to use a supported video format 

ows 
rmal Map, meaning you can load up a 

 

5) 
 
Anim a

loaded an image so above you see it 
listed, ‘X’ to delink, and how many in 
scene users of this image. 
Up here are ‘Image Options’ such as
automatic MipMap creation, UseAlpha
image if it’s 32 bit, and Fields for 
handling video fields.  By default Blen
MipMaps are used in Games, and if your n
you can turn it off. 
Take note of this icon ‘Movie’; if you are g
like and .avi as your image, this is used to tell Blender at render to extract the 
frames of the animation as single images. 

sually has MipMap on, however 

4) ‘Reload’ image button, plus the ‘Normal Map’ button, understand that this 
button does Not cause Blender to render out a normal map.  What it does is all
Blender to treat the Image Loaded as a No
8-bit grey scale or 24-bit image in and Blender will calculate it for use as if it
were a Normal Map. 
‘Repeat’ button to turn on image repeating and input areas for X/Y repeat values. 

nd Movie 
1) If no Animation File loaded all you 

normally see is a small arrow here, but if 
d the arrow becomes a button 

 

2) o 
ts 

 movie fram

3) er frame, Not on Output Render but 

 
 

one is loade
showing how many frames are in the
animation. 
‘Frames:’ is number of frames you want t
use from the animation, ‘Offset:’ offse
number of 1st e.  The arrow button simply places the whole number of 
animation frames over. 
‘Fie/Ima’ sets number of fields rendered p
number of fields used by the animation file and again deals with a video source. 



 
 

4) ‘StartFr(ame): starting frame to use, and Len(ght): how many frames to use. 
5) ‘Cyclic’  if the animation you are going to render has more frames than the 

animation used for the Texture, this Cycles the Image animation. 

p 
ew 

nd you may 
notice something, your texture does not show. 

 

 
splay Buffer and your Texture must 

o s 
‘Show Map in View Port’.  But no quick bu
 
Note:  The 3D View is using a Scanline ren p 

 in 
r, so it is not a drawback of using Blender. 

 
  So go ahead and for now load up a Bitma
Image of your choice and set your 3Dvi
for Textured Render Mode.  A

  Do a full Render and there it is.  Why?  
While the Bitmap is now associated with the
Material, it is not associated with the 3D 
View Window.  The 3D View is using its
own Di

be loaded there for it to show.  Those use t  using 3dsMax you will know doing this a
tton to do this in Blender. 

der and is not Raytracing, so while a Bitma
used as a Col(or) can be display, certain other Channels and their effects can not be seen 
in a 3D View Window currently with 2.42.  A number of these channels do not show
most other 3D programs eithe
 
GETTING IT TO SHOW UP IN 3D VIEW 
 
  Repeat: What you have to understand here is that Blender assigned the Image to the 
Texture, and the Texture is assigned to the Object (do a Full Render and check).  

owever the 3D View is designed for modeling and editing Objects, and depending on 
h to display a different Image (Color, 

ormal, Alpha…). 

ct 

ure on 

 Select Mode.  Now select 

ou’ll now want to go to a UV/Image Editor Window Type and here assign the Image 

 

H
what type of editing your doing you may wis
N
  To those ends in 3D View you can for your Editing purposes have different Images, 
even other than those used in your Material, and these are Not assigned at an Obje
level, but at a Face level. 
  So to see your texture in the 3D View you need to tell Blender your using this text
these Faces. 
 
Pick a 3D Viewport and set it’s Shading to Textured, 
and then go into UV Face
all the Faces of your Mesh 
 
Y
used by your Material to the 
selected .  It should show in the 
loaded texture list. 
 



 
 

  And here it is
material you
 
  Now try this, while still in UV Face Select Mode pick a Face 
from your Mesh (switched to Cube in Picture for ease of viewing). 
Then in the UV Editor Window load up another Image which can 

s 
 for this Face, and it 

ould appear on that Face in the 3D View.  But try a render and 
c

reference in the 3D Vi

 

, but remember this is your 3D View display, not the 
 will be Full Rendering. 

be done with the ‘Image’ hotspot.  Next using the up/down arrow
open up the Image List pick a different one
sh
ond texture, because in adding that second texture it was just for 
ew; you are Not modifying the Material. 

low and behold no se

Note:  There are other ways to achieve this display in Blender, and can be found in 
Tutorials found on the Web.  But to begin with use this methods to help you understand 
what is happening inside Blender. 

REALLY – REALLY BASICS ON UV EDITING
 

 
 
  This portion touches on how to do simple assigning and manipulating of UV co-
ordinates in Blender. 
 
  Let’s make it simpler by using a Cube so in Object Mode pick your Sphere and delete it. 

> Mesh> Cube (recall it is created 
t the location of your 3d/Marking Cursor and aligned to the view).  Then in your 

.  So in the Links and Pipeline> Link to Object area click the ‘List 
rrows’ next to Add New, here your previously created Material is included.  To save 

. 
 in 

Now add a Cube from the Info Window by using Add
a
Buttons Window> Shading> Material you’ll see no Material either OB or ME is 
assigned to this object
A
time just select it for assignment to your Cube. 
   
  Now setup a UV/Image Editor Window Type, you do UV Editing in that Window
As you may notice that as before your Cube though it has a texture it does not show
3D View, and you’ll have to reselect the Faces and use the UV/Image Editor to assign 
the texture to those Faces for display. 
 



  So set your ‘3D View Mode’ to UV 

 
re dotted lines and small purple dots.  

UV 

rti
means XYZ were taken and since they 

 in the Alphabet were used.  XYZ are letters 
 a point in 3D space, and used in Geometry to 

probably guessed it is what they are being used 
r in 3D Modeling, those points now being Vertices). 

terial’s 

Face Select and select all the Faces of 
your Cube, but then PAUSE and LOOK 
at your UV/Image Editor.  There you see 
a dark blue grid, but around the outside
a
  These represent your Cube’s current 
assignments, with the dotted lines are 
Edges and the purple dots are Vertices. 
 
(Note: UV {and W} correspond to the ve
UVW have any special meaning, yes, it 

ces on your Mesh as to XY{and Z}.  Does 

correspond to XYZ the next 3 letters down
normally used to denote the position of
define area’s and shapes.  Which as you 
fo
 
  Now in the UV/Image Editor use the Image List found there to assign your Ma
Image for display in the 3D View. 
 
My UV’s 
  On default creation of a Mesh, Blender assigns it an original set of UV’s.  You however 

ill not want to use those, but will want to create your own.  So for the moment you must 

ou setup where you are 
etting the UV’s you will be using for the Mesh.  Default at 

 for ‘Orco’ meaning Original Co-ordinates as 

ge
’s.    Make sure you’re still 

 Editing Mode and select all 
gain, go to Header Bar> 

Face> Unwrap UV’s, or ‘U’ key, or 
use the HotBox.  Up pops the UV 

 c
 
 
 
 

 
laying out your UV’s. 

w
go back into the Buttons> Shading> Material Panel, to the 
Tab for ‘Map Input’ from where y
g
Creation is
assigned by Blender.  But you want to lay out your own UV’s 
so you need to switch over to the ‘UV’ button. 
 
  Going back to the UV/Image Editor nothing seems to chan
has simply moved the Original Co-ordinates over to your UV

in UV
the Faces a

, that is because Blender 

Calculation List 
  Go ahead and try Cube-Cylinder-Sphere UV calculations from different 3dViews, and 

an have on how UV’s get laid out. take note in your UV/Image Editor the affect view

Depending on how your Model is aligned and the 
angle of your faces, certain views work better when



 
 For now just pick a simple Cube Projection, then just pick one Cube Face which you 

ill modify, and look to your UV/Image Editor to see how that particular Face‘s UV’s 

 
 

 I were 

e 

So go to a Top view and again bring up ‘UV 
Calculations’ by Menu-HotBox- ‘u’ key. 
  Now do a ‘Projection from View ½’ and 
check out the results in the ‘Editor’.  Why does 
it look that way, because a ½ means half of X 
and half of Y. 
Replaced Material to show. 

   
                                                                                                         show Mapping changes. 
 
 
 
 
 
  To edit specific 
UV’s you simply 
select them in 

w
are setup. 
 
 
 
 
 
 
 
 

  Now the texture I was using was a little busy, and it would be harder to notice if
to tile it.  So I went ahead and loaded another texture so you can tell the effect more 
easily.  This is where if you where modeling you might load a different Image then th
Material’s, just to make sure your mapping is correct.  Just follow the steps from earlier. 

  
  OK top face selected so for ease I’m going to 
do my new mapping from a top down view. 

 
Material changed to



the UV/Image Editor. A selected UV turns ‘Yellow’, and the standard selection of click
‘Editor’.  Also 

- 
‘shift’ click for multi selection- ‘b’ for marquee select works in the 
remember it Face(s) not just Face. 
 
 
 
 
 
 

 UV CALCULATION ITEMS TO NOTE: UV CALCULATION ITEMS TO NOTE:
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) Unwrap tells Blender to Unwrap and Objects UV’s and place them in the UV/Image 

X and 
a

 However if just ‘Project from View’ with no value, the projection covers the 3D 
iew’s Window area of view. 

MPORTANT TO REMEMBER

1
Editor.  You can build a Mesh and put UV’s on it with out immediately editing them, so 
when you want to work on the UV editing later you use this to load the UV’s previous 
assigned into the Editor. 

) When you do a ‘Project from View’ with 1/1 or1/2… Blender takes the max 2
m x Y values that the Face(s) selected have and the project just covers that area.   
  
V
 
 
I  

a) When working with 2d Materials you first have to load up and image in 
Shading-Texture.  That then gets associated in Shading-Materials. 

al Co-ordinates (Orco) but to create and 

 in 
V/ 

 

b) Blender assigns default Origin
Manipulate UV’s you need to switch where Blender is looking for its 
UV’s in the ButtonsType- Shading- Materials-Map Input tab.  This 
must be set to UV. 

c) To see your Textured Materials in Blender you must first in 3D View be
UV Select Mode and pick the Faces of your object.  You then Use the U
Image Editor to specify which Image to display on those Faces. 

  
2 Useful Scripts Found in UV/Image Editor> UV’s 
 When you click the ‘UV’s’ ho tspot towards the top you will find two Python Scripts 

at may prove useful to you. 

 
 
 
 

th
 
 
 



1) Archimap UV Projection Unwrapper:  Will attempt to automatically lay out you
y flattening out the Faces

r 
UV’s b  of your Mesh. 

If you don’t like how Archmap laid out your UV’s try tweaking the values for Angle 
Limit (angle of face normal), the Bleed Margin, and Fill Quality (try’s to better fill the 
whole image). 
 

2) Save UV Face Layout save your UV unwrap out as a .tga bitmap for taking into a 
paint program like Photoshop. 

 
Size – Image is square so only 1 value (try using 

p – wrap to image size. 
All Faces – clicked all faces used, if not only 

e 
name. 

Edit/Editor: - select to autom age editor (Photoshop, 
to provide path to editor. 

 

powers of 8) 
Wire – thickness of line used in image to show 
edges. 
Wra

selected faces. 
Ob(ject) – use object name as basis for imag

atically go to an external im
Painter…etc), input space 
 
 
 
 
 
 
 
 



These two scripts should be by default in Blender 2.42a 
 
 
Results of Save UV Face Layout 
 
 


